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Last Updated 10/7/02

VIDEOPAPER FROM START TO FINISH: A CHECKLIST

1.  Creating a folder
2.  Digital Camera
3.  Video: Editing in iMovie
4.  Text
5.  VP Builder

7.A. Inserting the movie
7.B. Inserting the text
7.C. Naming the text
7.D. Adding play buttons
7.E. Naming the videopaper

6.   Editing your videopaper
7.   Viewing the videopaper

1. CREATING A FOLDER:

1.1 Select New Folder under File menu
1.2 Untitled folder appears on desktop
1.3 Click gingerly on "untitled folder" and type your name in its place

2. DIGITAL CAMERA:

2.1 Play tape in mini DV player next to Mac and be sure that the fire wire is
connected. Alternatively, connect camera to a fire wire. [Fire wires are
short cables that transport video They connect to the fire wire port of the
back of the Mac with a rectangular plug and to the camera or digital video
player with a smaller plug that fits in the dv slot usually found in a front
panel on the camera].
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3. VIDEO: EDITING IN IMOVIE:

3.1 Open iMovie. When you first open it, there may already be someone
else’s work on the screen. This is because iMovie will automatically open
into the last project that was being worked on. MAKE SURE that you
create a NEW PROJECT or that you find your own project in your folder (if
you are returning to continue work) before you start working in someone
else’s movie.

3.2 Select New Project from the File dropdown menu.
3.3 Select your folder from the drop down menu.
3.4 Name your video.  Press "Create"
3.5 Now begin playing your video by pressing the controls under the iMovie

monitor. Treat this like a VCR.

Note: There are two settings in iMovie – “Camera” (which has a little icon
that says “DV” on it) and “Editing” (which has
an that looks like a little piece of film). When
importing video from your tape make sure DV is
selected. When editing, make sure that the film
clip is selected.

3.6 The “Import” button in the iMovie program allows you to transfer the
footage from the tape to the hard
drive of your computer. You may
want to preview your footage
before you begin importing it.
Movie images take up disk space
(at roughly a rate of five minutes =
1 gigabyte). Most hard drives have
a total of 40 gigabytes of space.
Be careful not to transfer half-hour
blocks of video, as you may run out of room.

3.7 Every time you click on “Import,” iMovie creates a new clip for you. These
clips appear in the clip shelf
on the upper right-hand
corner of the iMovie screen.
The numbers in the clip
indicate the
minutes:seconds:frames
(iMovie captures 30 frames –
still images – per second of
digital footage. You can
freeze any one of these frames as a “still image.”)
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3.8 By clicking on a clip in the upper right-hand corner, you select it as one
that you would like to edit.

3.10 Cutting film clips: To break one clip into two, place
play head at the breaking point and select “Split
Video at Play head” under the edit menu.
IMovie cuts the original clip into two pieces – the
original and its derivative (identified with a slash after the original name).
Everything to the left of
the cut is considered
original, and everything
to the right is
considered derivative.
IMovie will not throw
anything away for you
– it is up to you to click
and drag your
throwaway to the trash
icon on the right-hand
side of the screen. You
can then repeat this process as many times as you like in order to edit the
film clip down to exactly the footage that you want.

3.10 Sequencing film clips: Once you have edited the clips and are happy
with your choices, click and drag clips within the clip shelf to arrange the
sequence in which you would like them to be viewed.

3.11 Repeat these procedures until you have assembled your final edited film
on the bottom of the screen in the sequence that you
would like them viewed. If you would like to review the
complete film at any time, click on the left double-arrow
icon that has a vertical line next to the arrow. This will
take you back to the beginning of the clip sequence.
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3.14 EXPORTING THE MOVIE: When
you are finished ordering the clips
that you have edited, save your
project. Go to the File menu
choose Export Movie.

3.15 Choose to export the movie to
Quicktime (from the pulldown
menu where it says “camera”).

3.16 From the pulldown menu, choose
to export it as CD-Rom movie, medium.

3.17 When it asks you to name the movie and choose a location, MAKE SURE
THAT:
a) you keep the .mov extension on the end of the file name
b) you direct it to be exported to your folder, along with the rest of the

videopaper content.
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4. TEXT: start with one of the following applications: (A), (B) or (C)

(A)  Dreamweaver: Because this is both a word processor and an html editor, and
feeds into Videopaper Builder cleanly, this is the best program to use.

4.1 Type in text as you would in a word processor.
4.2 Preview your text through an Internet browser by clicking on globe

icon in the upper center of the Dreamweaver window. This will open up a
preview window in Internet Explorer.

4.3. When you SAVE your document, keep the .html extension at the
end of the file name. Be sure that you do not leave any spaces in the file
name. (Use underscore “_” if you need to designate a space.)

(B) Word: If you don’t have Dreamweaver, use Word to type your text and save as web
page.

4.4 Open Word.
4.5 Create a new document.
4.6 Before typing your document, save document as Type: Web Page

(HTML)
4.7 Typeyour document.
4.8 When you SAVE your document, keep the .html extension at the end of

the file name. Be sure that you do not leave any spaces in the file name.
(Use underscore “_” if you need to designate a space.)

To make changes and additions to your html file:
4.9 Open up Dreamweaver
4.10 Click File, Open…
4.11 Select your .htm or .html file to edit your file in Dreamweaver

(C) Simpletext: (If you don't have Word or Dreamweaver)

4.12 Type your text and save as .txt
4.13 Save text as .html when you are finished. When you SAVE your

document, keep the .html extension at the end of the file name. Be sure
that you do not leave any spaces in the file name. (Use underscore “_” if
you need to designate a space.)
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5. VP BUILDER:
This is the software that actually combines the movie, text, and slides in order to form a
videopaper. All of your files must be kept in the same folder in order for VP Builder to
create your videopaper.

5.1 Double-click on the Videopaper Builder v 1.0 icon.
5.2 Select New Videopaper.
5.3 Do not rename the file name – leave it as index.html.
5.4 Put the file (the new “entry point”) into your folder and save. BE

CAREFUL that you save this file into your folder.

5. (A) INSERTING THE MOVIE:

5.5 Click on the Video icon. This will open
a Movie box with its own menu.

5.6 To insert your movie, click on Movie
Menu and drag your mouse to Set
Video To – the name of your movie file (in QuickTime, with the .mov
extension) should appear to the right. Move your mouse over the name
and click.

                  

NOT WORKING? If your movie file name does NOT appear when you do
this, it is because it does not have the .mov extension or because it was
exported to somewhere outside of your folder. Something went wrong
when you exported the video from iMovie to QuickTime. You have two
options: A) Revisit the instructions above and repeat the exporting
process. B) Alternatively, you can locate your movie by searching for it by
title using the “Sherlock” application (go to your desktop and double-click
on the icon with the magnifying glass).

5.7 Name the movie. From the Movie Menu, select Set Video Title and type
in the new name of the video.
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5. (B) INSERTING THE TEXT:

5.8 Insert sections one at a time
(each.html document gets its own
section).

5.9 Click on the orange button in the upper
left-hand corner of the screen Add
Section – the name of your document
should appear as a choice in the
menu.

NOT WORKING? If your document does NOT appear as a choice in the
menu, it means that it does not have the.html extension. Rename the file
(by clicking on the file name in the file directory and re-writing the name
and the extension) so that it reads .HTML at the end.

5.10 Repeat this process as many times as you need to in order to insert all of
your text in separate sections.
NOTE: make sure that the file name that you created for your html
documents DOES NOT have any spaces.

5. (C) NAMING THE TEXT SECTION:

5.11 Go to the Edit menu and select Edit Sections.

5.12 The menu presents the
Section Names and the
File Names.

5.13 Use your cursor to
highlight the section
name you wish to edit
(the corresponding file
name will also be
highlighted).

5.14 Click the Edit button.
5.15 Type the name of the section.
5.16 Choose the presentation of your sections: either POP-UP or TABBED

dividers.
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5. (D) ADDING PLAY BUTTONS:

5.17 You must first select the section of video
you would like to associate with a “play”
button. Start by holding down the
SHIFTkey.

5.18 Click and use your cursor to drag the play
bar at the base of your movie (notice how
it highlights in dark the section that you
have selected).

5.18 Release the cursor and the SHIFT key
when you are finished selecting.

5.20 Position the cursor in the text where you want the play button.
5.21 Click with your mouse button.
5.22 Go to the Controllers that are displayed along the

left-hand side of
the screen.

5.23 Click on the Insert button to insert the controller
entitled Play (notice that when you insert the Play
button, the time that you have selected to play will
appear in brackets alongside the Play button – in
minutes: seconds: frames: tenths of a second).

5. (F) NAMING THE VIDEOPAPER:

5.24 Go to the Edit menu.

5.25 Select Edit VP Title and rename the
videopaper.

5.25 Save your work.
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6. EDITING YOUR VIDEOPAPER:

If you wish to edit an existing videopaper:

6.1 Open Videopaper Builder
6.2 Choose the option to “Open

Existing Paper.” A window will
open allowing you to search
through a directory of folders.

6.3 Find your folder.

6.4     Find the file named “INDEX.VPML”
and double-click.
NOTE: This is a
different file from the
one that you open to
view your work.
“HTML” stands for
Hypertext Markup
Language, while
“VPML” stands for
“Videopaper Markup
Language,” the code
used by the
Videopaper Builder
software.
INDEX.VPML = editing
INDEX.HTML = viewing
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7. VIEWING THE VIDEOPAPER:

NOTE: if you do not close VPBuilder before you preview your videopaper, you will get
graphical errors in the Internet browser. These are “phantom” errors (they are not really
part of your videopaper). To avoid seeing these, close VP Builder before viewing your
videopaper.

Videopapers are viewed using the same software that you use to surf the Internet –
Internet Explorer or Netscape Navigator. Your computer will have a default browser that
it uses to browse the Internet, so all you have to do is:

7.1 Open the folder where the videopaper resides.
7.2 Find the file called INDEX.HTML
7.3 Double-click on this file.
7.4 The videopaper in that folder will automatically open in a new browser

window. You do NOT have to be connected to the Internet to view a
videopaper. To speed performance, you should copy the videopaper from
the CD to your hard drive.

NOTE: when you are developing the videopaper and wish to check your
progress, you must SAVE the videopaper before viewing it. If you have already
viewed an earlier version and that browser window is still open from the previous
viewing, you can either:
a) Exit the browser completely and re-open it by double-clicking on the
INDEX.HTML file (this is the most reliable method); or
b) Click the refresh button in the browser in order to pick up the latest changes
you have made.


